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1 OF 10 (1-4 CREATING A REPORT)

Once you have created and populated your database, you may want to present your data on hard copies.  For example, you may want to print invoices using data from your database.  To do so, you can create a report specifying the data to be included and the layout of the report.  A report gathers data, which it then organizes in a way that you specify and sends the output to a printer.  Reports gather their data either from a table or from a query.  There are three basic report layouts:

• columnar

• tabular

• justified

Columnar reports use one line for each field in the underlying table or query.  Tabular reports print a whole record on each line of the report.  And justified reports have completely customized layouts that are useful for invoices and statements, for example.  You can group reports on the basis of one or more fields - this allows you to organize your information in different ways.  For example, a customer listing report grouped by country prints all the customers in a country below the first value it finds for country.  As soon as the value for country changes, it starts a new group of customers.  To create a report, you can use a wizard and specify record sources, report layout, and report format.  Alternatively, you can use the AutoReport feature, which creates either a columnar or tabular report and then applies the previous autoformat you used to a selected dataset.  You can also design a report from scratch in Design view.
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Each report is divided into several sections.  The sections control the layout of the report, that is, where on the page data gets printed.  And they control how data repeats per page or per report.  Information in the Report Header and Report Footer sections appear on the first and last page of the report.  So, for example, the report header may contain a title for the report as a whole.  And the Report Footer may display a final total for numbers, for example.  The Page Header and Page Footer sections contain information that is repeated at the top and bottom of each page.  These sections typically contain information such as the print date, column headings, and page numbers.  For example, you can calculate page totals - running totals - for numeric values in the Page Footer section.  If you want to group sets of records, you can do so by creating a group based on a specified field.  These groups can have their own header and footer sections.  Suppose you want to print a report that shows product ordering patterns.  For each product you want a list of the customers that ordered the product.  To create such a report, you would have to create groups based on the product primary key, while the Detail section will contain the customers' names.
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Controls are the building blocks of reports - they display data, perform actions such as calculations, and decorate the report.  Controls can be bound, unbound, or calculated.  Bound controls display, enter, and update fields in a database and are linked to a data source in an underlying table or query.  Unbound controls have no data source and include objects such as lines, pictures, or special titles.  Calculated controls use data from the underlying table, the underlying query, or other controls on the report as input to expressions.  When the report prints, the value of that expression appears in place of that control.  Access provides the control Toolbox to insert controls on a report.  Each button represents a control, except for the last button which opens a list of other available controls.  Bound text boxes, list boxes, combo boxes, and object frames contain data from the report's underlying query or table.  You can use a bound object frame to print a picture of each product contained in a table.  Both bound and unbound object frames insert OLE objects in the report, such as pictures, spreadsheets, and documents.OLE is an acronym for Object Linking and Embedding, which is a Microsoft standard that allows you to link or embed objects created in one application to objects in another application.  Unbound text boxes, list boxes, combo boxes, and object frames are not linked to any table or query.  For example, you can use an unbound text box to print the current user's name on a report.  And an unbound object frame may link to a Word document containing sales terms and conditions.  Fields that contain Yes/No and Bit data types can be linked to checkboxes, option buttons, and toggle buttons.  When these controls are bound, they display as selected when their field has a value of 1 or True.  An option group gathers several option buttons of which one displays selected when the report prints.  Text options in the option group must be linked to a numeric value.  To create an attractive report, you can use labels, lines, rectangles, and image controls.  Labels are always unbound and usually contain informative text such as titles.  Image controls link to common types of graphic file.  Line and rectangle controls are useful for visually grouping data, for example you can separate each record on the report with a line.  You can use page break controls to force page breaks at specific places in your report.  And subreport controls insert another report in the current report.
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Suppose that you want to print a telephone list that contains the company name, contact persons, telephone numbers, and fax numbers of all your customers.  You want to use the Report Wizard to create the report.  When you have created the report, you want to enhance it by placing a rectangle around the title.  You start by clicking Reports in the Objects bar of the Database window.  And you double-click the Create report by using wizard option.  You can also start the wizard by clicking the New button and then selecting Report Wizard.  The Customers table, which contains the information you want, is already selected so you only need to select the fields you want included in the report.  You select CompanyName and you click the Add button.  Then you add the ContactLastName, ContactFirstName, PhoneNumber, and FaxNumber fields and you click Next.  If you choose fields from multiple tables, the wizard automatically builds an underlying SQL query to combine the information from the tables.  You do not want any grouping levels so you click Next.  You want to sort the records using the CompanyName field so you select it.  And you click Next to move to the next page of the wizard.  You select a layout for the telephone list report - a tabular layout in this case - and you click Next.  You want the report in the Bold style, so you select it and click Next.  On the last page of the wizard you type a name for the new report.  You decide to preview the report once it is created instead of modifying the design, so you select the Preview the report radio button and you click Finish.  Access then shows you what the populated report looks like.  To add controls to the report, you need to be in Design view so you click the View button.  You want to add the CompanyName field to your report.  So you click the CompanyName field in the field list and you drag the control to the Detail section.  Access has placed both the bound text box and a label for the text box in the report, but you do not want the label so you select by clicking it.  You can also select the label from the object drop-down list.  And you press the Delete key or you click the Delete button.  You can now resize the bound text box by dragging its object handles.

5 OF 10 (5-8 MODIFYING CONTROLS AND SECTIONS)

It is likely that you will want to change the design of most reports, even if you use a wizard or the AutoReport feature to create them.  The sections and controls in a report have many properties that you can change.  To access the properties of an object you right-click the object and select Properties from the shortcut menu.  Or you can double-click the object.  Alternatively, you can select the object and choose Properties from the View menu or click the Properties button.  To select an object you can either click it or select it from the Object drop-down list.  Access groups the properties of report sections and controls into four categories - Format, Data, Event and Other.  The Format tabbed page lists properties such as colors, fonts, borders, position, size, visibility, and special effects.  The Data tabbed page lists the properties of the data source for that control.

On the Event tabbed page you can specify procedures - usually written in Visual Basic - that must execute when certain events occur, such as the opening of a report.  For example, you can ask Access to print an error message on screen if the report runs and finds no data to print.  Any properties not listed on the Format, Data, or Event pages are listed on the Other page.  In the example shown here, the control's name, whether it prints vertical or not, and its tag are listed.  You can use the Tag property to add explanatory notes, for example, to the control.  You can view and change all the properties at once on the All tabbed page.  A report can only have one width that applies to all sections, in other words, you cannot change the width of one section without changing it for all sections.  To change a report's width, you simply position the insertion point anywhere on the vertical border of the report and drag the report to the size you require.  You can use the same technique to increase or decrease the height of a section, and different sections may have different heights.  You can move objects on the report layout by selecting them and dragging them to their new positions.  An object will move if the pointer hovering over it turns into a hand.If the hand has an index finger pointing upward, the move will affect only the selected object and not its associated label or data box.  To resize an object, you need to select it and drag it by one of its object handles to the required size.  When you release the mouse button, the object has a redefined size.
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Suppose that you have created a report that prints invoices from the CustomerOrder database.  However, the lines separating order items are too short so you want to resize them and thicken them.  You also want to align the order totals with the Line Total column.  To modify controls, you click the View button to switch to Design view.  Then to adjust the lines separating the order items, you scroll to the right in order to view the end of the separator lines and you select one line.  Then you hold down the Shift key and select the other line.  You lengthen the lines by dragging one line's right-hand object handle to its new end point.  And you release the mouse button to fix the lines' end points at that position.  You can change the thickness of both lines at the same time by holding down the Shift key and selecting the line in the OrderID Header section while the line in the Detail section is still selected.  Then you right-click and select Properties from the shortcut menu.  You change the properties of a section by right-clicking its gray horizontal bar or any part of the section that contains no controls.  On the Format tabbed page of the Multiple selection dialog box you click the Border Width down-pointing arrow and you select an option - 2 pt in this case.  And to close the Properties dialog box, you click the Close button in the top right-hand corner.  To align the order totals with the Line Total column, you adjust the view so you can see all the totals' controls.  You select all the totals at once by clicking and dragging across all the controls creating an outline around the controls.  You can also effect a multiple selection by clicking one control and holding down the Shift key while you select the others.  Then you drag the selection to the desired position.  To view the changes, you can preview the report.  You can see that the lines separating items are longer and thicker and that the order totals are aligned with the Line Total column.

7 OF 10

Calculated controls derive their printed output from an expression.  The expression may have database fields and report controls as input.  Text box controls are commonly used to create a calculated control but any control that has a Control source option may function as a calculated control.  You can enter the expression directly into the Control Source property field or you can use the Expression Builder to help you define the expression.  The Expression Builder's result window displays the expression as you build it.  Below the result window is a row of operators that you can use in your expression.  The three lower windows allow you to display possible sources of data, functions, and operators.  For example, if you choose Built-In Functions, the Expression Builder lists the available categories of function in the center window.  And it displays the functions available for that category in the window on the right.  In the example shown here the expression counts how many CompanyName entries appear in the Customers table.  As you can see, all expressions for calculated controls start with an equal (=) sign.  When the report runs, the control's value is calculated according to the expression and printed on the report.  Because the control appears in the Report Footer section, it prints at the end of the report above the Page Footer section.
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Let's say that you want to build an expression that calculates the order total on the Invoice report.  The order total is defined as the sum of the Subtotal, FreightCharge, and Sales Tax controls' values.  To calculate the order total, you right-click the Order Total control's data box and you select Properties.  To open the Expression Builder, you click the Control Source Build button.  You need to start the expression with an equal sign so you click the = button.  Access will automatically add an equal sign to the final expression if you forget to add it.  When you enter the Expression Builder, it automatically lists the current report's fields so you scroll down until you can see the Subtotal, FreightCharge, and Sales Tax controls.  To insert the value of the Subtotal control, you double-click the control in the center window.  To insert the value of a control in an expression, you can also double-click on <value> in the right-hand window.Or you can select the control in the center window and click Paste.  To add the values of the controls, you add a plus sign to the expression by clicking the + (plus sign) button.  Then you double-click FreightCharge.  And, having inserted another plus sign, you double-click Sales Tax.  You click OK to enter the expression into the Control Source property.  And you click the Close button to accept the new value of the Control Source property.  The Order Total control has been redefined as a calculated control.
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Having completed the design of your report, you may now want to see what it will look like when it prints.  To do this, you can preview the report by selecting an option from the View drop-down menu.  You can also click the Print Preview button or use the View menu.  The Print Preview option gathers all the data from the underlying table or query to print the report to screen.  The Layout Preview option, on the other hand, gathers only enough data to display an approximation of what the report will look like, so it executes faster than Print Preview.  Both the Print Preview and the Layout Preview options result in the same Preview screen with the same options and functions available to you.  In the Preview window you can use the navigation buttons at the bottom of the window to move between pages of the report.  For instance, if you click the single right-arrow, the report advances to page two.  And clicking the arrow meeting a bar on its right advances you to the last page of the report.  The left-pointing arrow takes you to the previous page.  And the arrow meeting a bar on its left takes you to the first page of the report.  When you are in the Preview window, the pointer becomes a magnifying glass with either a + (plus sign) or a - (minus sign) icon in it.  The + icon causes Access to zoom in when you click the page, while the - icon causes Access to zoom out.  You can zoom alternately in and out by clicking the Zoom icon.  The position of your click on the screen more or less determines the center point of the new zoom position.  When you zoom in on a section of the report, scroll bars appear that you can use to change the portion of the report that is visible.  You can preview the report page by page or you can view two pages at the same time.  Alternatively, you can view up to 20 pages simultaneously by selecting the number of pages you want to view from the Multiple Pages drop-down box.  The Zoom drop-down list enables you to enlarge - greater than 100 percent - or reduce your view of the report.  Viewing a report at 100 percent means that you see the objects on screen at exactly the same size that they will appear on the printed page.  The Fit option means Access displays the number of pages you selected all on the screen.  Clicking the Close button returns you to Design view.  You can also click the View button or use the View menu to revert to Design view.
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Before you print a document, you may want to change the page setup.  To do this, you select the File menu and you select Page Setup.  You can also right-click the report in the Preview window and select Page Setup from the shortcut menu.Alternatively, the Print dialog box has a Setup button that opens the Page Setup dialog box.  In the Page Setup dialog box you can set the size of the top, bottom, left, and right margins for the report.  When you change a margin, Access automatically adjusts the sample so that you can see the effects of your change.  The Print Data Only checkbox allows you to print only those controls that retrieve data from the underlying query or table.  So objects like titles, graphics, and labels do not print.  On the Page tabbed page you can change settings for the paper's orientation and size and the source of the paper at the printer.  You can also select a printer other than the default by clicking the Printer button.  The options that are available on this tabbed page derive directly from your Windows' printer setup.  You can create a report with more than one column of details per page by configuring the settings on the Columns tabbed page.  These reports print with the report and page headers and footers spanning the full width of the page.  However, group and detail sections print in columns on the page.  You can define the number of columns and the width of the space between columns and rows in the Grid Settings section.  The Column Size section allows you to specify the width and height of each column.  You can use the Same as Detail checkbox to duplicate the report's Detail section settings in the Width and Height text boxes.  If you define the column size as 3", all controls that extend beyond 3" from the left edge of the Detail section will be cut off when the report prints.  The Column Layout section determines how records follow one another in the columnar report.  If you have two columns in your report and you select Across, then Down, record two prints to the right of record one, and record three prints below page one.  The Down, then Across option prints record two below record one and continues until it reaches the bottom of the page before it proceeds to print the next record at the top of the right-hand column.  When you have finished the page setup, you select File - Print to open the standard Windows Print dialog box.  The dialog box includes a Selected Record(s) option that enables you to print the report only for those records that you have marked with the record selector.  The record selector is available in the Form and Datasheet views.Objects that have the Selected property set to True by a macro or application can also be printed in this way.  When you are satisfied with all the print settings, you click OK to send the report to the printer.  Access then informs you that it is sending the report.  You can print a report directly, without accessing the Print dialog box, by clicking the Print button.Access then prints the report using the most recent settings for the page setup and printer setup.

END OF REPORTS

SUMMARY: You have seen how to create, modify, and print reports in Access 2000.  A report gathers data from either a table or a query. It then organizes the data in a way that you specify and sends the output to a printer. To create a report, you can use a wizard, the AutoReport feature, or you can design one yourself. The three basic report layouts are columnar, tabular, and justified reports.  Each report is divided into several sections that control where on the page data gets printed and how data is repeated per page or per report.   Controls are the building blocks of reports. They display data, perform actions like calculations, and decorate the report. Controls are bound, unbound, or calculated. To display data in a report, you can use text, list, combo, option, and option group controls. And to improve the appearance of your report, you can use label, line, rectangle, and image controls. You can use page break controls to force new pages in a report. Subreport controls enable you to combine data from various data sources in one report.  The Properties window lists the attributes of each report control and report section. The list of properties is divided into four categories, which are displayed on the Format, Data, Event, and Other tabbed pages. On the All tabbed page you can see all the properties together.  A report can have only one width but you can set the height of each report section individually. You resize a report section by dragging its handles in the rulers. You resize or move a report control by manipulating its object handles.  Calculated controls derive their printed values from expressions. The expressions obtain their inputs from tables, queries, or other controls.  Before sending a report to a printer, you can preview the way it looks on screen. The Print Preview view gathers all the data from the underlying table or query to print the report to screen. The Layout Preview view, on the other hand, gathers only enough data to display an approximation of what the report will look like.  The Page Setup dialog box allows you to set options for margins, paper size, paper sources, and printers. These settings derive directly from your printer setup. You can also create columnar reports in this dialog box.  In the Print dialog box you can, apart from the usual Windows options, choose to print preselected records only.

UNIT TEST:

1. A report control that is linked to an underlying data source, such as a table, is called a _____ control.

a. unbound

b. bound

c. calculated

2. To print the data from a control at the very end of a report, you must position that control in the _____ section of the report.

a. Report Header

b. Detail

c. Report Footer

d. Page Footer

3. Which of the following controls do you use to print a Word document in an Access report?

a. Text box

b. Combo box

c. Unbound object control

d. Bound object control

4. Which of the following controls do you use to print the current user's name on a report?

a. Bound text box

b. Unbound text box

c. Label

d. List box

5. Which of the following actions will resize a report control?

a. Selecting it and pressing the Page Up or Page Down keys

b. Selecting it and pressing the plus or minus keys on the numeric keyboard

c. Changing its height and width properties in the Properties dialog box

d. Manipulating its object handles when it is selected

6. Calculated controls derive their printed output from _____.

a. a table

b. an expression

c. a query

d. a user

7. Which of the following is a valid expression for a calculated control?

a. @SUM(UnitPrice)

b. !SUM(UnitPrice)

c. %SUM(UnitPrice)

d. =SUM(UnitPrice)

8. Choosing _____ for a report gathers all the data from the underlying table or query to print the report to screen, while the _____ option gathers only enough data to display an approximation of what the report will look like.

a. Print Preview

b. Layout Preview

9. When you preview a report before sending it to a printer, a zoom factor of greater than 100 percent _____ the preview on screen.

a. reduces

b. enlarges

c. doesn't affect

10. Access allows you to preselect records for printing.

a. True

b. False

ANSWERS:

1. b

2. c

3. c***(d)

4. b

5. c & d

6. b

7. d

8. 1st blank: Print Preview, 2nd blank: Layout Preview

9. b

10. True
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1 OF 7 (1-3 CREATING AND MODIFYING REPORTS)

Instead of using a wizard or the AutoReport feature, you can design a report from start to finish yourself.  Suppose that you want to create a report that prints a catalog of Award Sportswear's products.  You want to include all the fields in the Products table but you don't want to use a label for the ProductName control.  You also want to change the label of the ProductID control to Order Code and you want to insert a copyright notice and page numbers on all pages.  To create a report, you click the New button in the Reports Database window or you double-click the Create report in Design view option.  The advantage of using the New button is that Access gives you the opportunity to preselect a table or query on which the report will be based.  You can select a table or query to base a report on in the Properties window.To base a report on multiple tables or queries in Design view, you need to create a query - using the Expression Builder or by typing the SQL statements - in the Record Source field of the report's properties.  In the New Report window you select Design View and the Products table and you click OK.  In Design view Access provides a list of the fields available in the Products table.  To insert a field, you select it from the list and then drag it onto the report's design area.  Access inserts the field as a control that contains the label and a databox that contains a reference to the correct field in the table.  You want to delete the label for the ProductName field, so you select it and press Delete.  You insert the ProductID and UnitPrice fields in the same manner.  In the case of the ProductID field you want to change the label to Order Code so you open the Properties dialog box and type the new text in the Caption text box.  You can also change the caption by typing the text into the label box directly in Design view.  When you have added all the fields that you need, you can add labels, titles, and other enhancements.  To do this, you need to open the control Toolbox.  You click the Toolbox button to open the control Toolbox.  To insert a copyright notice, you click the Label button in the Toolbox, click in the footer section, and you type the copyright notice.  You select Insert - Page Numbers to specify how you want the report pages to be numbered.  You can specify the format, position, and alignment of the page numbers.  If you have a first page that does not contain any data, you may not want to print the page number on that page so you clear the Show Number on First Page checkbox.  The Inside and Outside alignment options apply to reports that have different margins for odd and even pages.The Inside option prints the odd page numbers on the left and even page numbers on the right, while the Outside option does the reverse.  You click OK to accept your page number settings.  This process inserts a calculated control that uses common expressions in the Page Footer section.
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Suppose that you want to make some changes to the Product catalog report.  You want the Award Sportswear logo to be printed on top of every page in the report.  The Detail section is wasting space on the report at the moment so you want to resize it.  And you want to widen the report to use the full width of the paper size and center the objects to the new report width.  Finally, you want to print two columns of records per page and place a rectangle around each record to separate them visually.  To place a picture in the report, you click the Image button in the control Toolbox.  You can also select the Insert - Picture option.  As you want the picture to appear on every page, you define an area for the picture in the report's Page Header section.  The Insert Picture dialog box opens automatically and you select the picture's filename and click OK.  The logo appears in the Page Header section but you see that the control is too small for the image.  To automatically resize the image control to the picture's size, you select the control and choose Format - Size - To Fit.  And the control is resized to the size of the image.  You need to reduce the size of the Detail section in order not to waste space on each record.  To do this, you click the vertical ruler above the Page Footer's gray button.  And you drag the Detail section to the size you want it.  At present the width of the report is five inches, which means it wastes paper by not using the full paper size, so you want to widen it by adjusting the report's width.  To access the properties of the report, you right-click the square at the junction of the two rulers and you select Properties.  You can also select Report from the object drop-down list and click the Properties button.Or you can double-click the square at the junction of the two rulers or you can click anywhere on the dark gray area outside the report.  You set the report width to 6.5" - 8.5" minus two one-inch margins - and you close the Report dialog box.  You will need to manually center the image to the new report width by dragging it to the center of the Page Header section.  It will be possible to fit two columns of product records on the page and you wish to do so in order to save space so you select the File menu.  And you select Page Setup to access the Page Setup dialog box.  On the Columns tabbed page of the Page Setup dialog box you specify two columns and their width and height settings.  To separate the records you add a rectangle around all the controls.  The report now previews as shown here.
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Design view contains the Format menu, which can help you with the layout of your report.  Suppose you have a grid of controls as shown here.  You want to align the left-hand column of objects to the left and the right-hand objects to the right.  You also want equal vertical spacing between all the objects in the left-hand column and you want to increase the horizontal spacing between the two columns.  To align the left sides of the first column of controls, you select them by clicking in the Detail section and defining a rectangle around them.  Then you select the Format menu.  You select the Align option.  And you select Left.  All the selected controls now have the same horizontal position for their left sides.  To align the right-hand column of controls, you first select all of them.  Then you select Format - Align - Right.  All the selected controls now have the same horizontal position for their right sides.  To have an equal vertical distance between each of the controls in the right-hand column, you select them and choose Format - Vertical Spacing - Make Equal.  Access distributes the controls equally between the top of the first and the bottom of the last control.  It is possible to work with a number of controls as though they were one object.  To do this, you select the controls and you select the Format menu.  Then you select the Group option.  You can now work with these three controls as one object.  To resize all the controls in the group to an equal width - that of the widest control - you select Format - Size - To Widest.  Access enlarges the two smaller controls with their left sides as anchor point.
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To enhance the appearance of your report, you can change the properties of controls and sections.  For example, you can change the font size, underlining, and text alignment of text box controls.  Suppose you want to change the appearance and layout of the Detail section of your report.  You want to move the ProductName control to the center of the Detail section, change its font size to 14, and underline and center the text.  You also want to align the text in the ProductID and UnitPrice controls to the left and sort the Detail section alphabetically on the ProductName field.  To begin, you move the ProductName control to the center of the Detail section by clicking it and dragging it to its new position.  Then you access its properties by right-clicking the control and selecting Properties from the shortcut menu.  On the Format tabbed page you choose 14 from the Font Size drop-down list.  And you choose Yes from the Font Underline drop-down list.  Finally, you align the text in the center of the control by choosing Center from the Text Align text box.  You close the Properties dialog box and return to Design view but you see that the text is now too large for the control.  To rectify this, you select the Format - Size - To Fit option.  The control has been resized to accommodate the larger text.  When you return to the report, you find that the Detail section is not large enough to accommodate the control.  So you access the section's properties by right-clicking the gray button on the ruler next to the section and you choose Properties from the shortcut menu.  You can resize the section by dragging its lower margin to a new position on the ruler but, in this case, you resize the section in the Properties dialog box so that you can enter an exact value for the section's height.You can then use the same value for the height of the rectangle that surrounds each record so as not to print white space between records.  You enter a new height for the Detail section - O.7" in this case.  Then you click the rectangle and Access switches to the rectangle's Properties dialog box where you enter 0.7" as its height as well.  To align the text in the ProductID and UnitPrice controls to the left, you select them and change their Text Align property to Left.  And you close the Properties dialog box.  To sort the Detail section alphabetically on the ProductName field, you right-click its button on the ruler.  Then you select Sorting and Grouping.  And you select ProductName from the Field/Expression drop-down list.  When you preview the changed report, it appears as shown here.
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Suppose you want to print a picture in the background of the report.  To add a picture to a report, you access the properties of the report by right-clicking the square at the junction of the two rulers and selecting Properties from the shortcut menu.  Then you click the Build button next to the Picture property.  You select the filename for the picture that you want in the background and you click OK.  The path to the picture now appears in the Picture text box.  The picture can be either linked or embedded.  This property is available for all graphics that you insert in the report.  Linked pictures reference the source file so that changes to that file will be reflected in the picture on the report, whereas embedded pictures are copies of the source file's image.  In this case you accept the default Embedded option.  You can choose to size the picture to the page size - without distorting its aspect ratio - by selecting Zoom as the value for the Picture Size Mode property.  The aspect ratio of a picture refers to the relative proportions of its height and width.  Or you can stretch it to fill the whole report regardless of the effect on the picture.  Choosing Clip displays the picture in its original size.  The Picture Alignment drop-down list allows you to specify where the picture is anchored on the report.  For example, you can select Center to place the picture in the center of each page.  If you select to tile the picture, the image is placed in the left-hand corner of the report - in its original size - and repeated across the page using the grid specified in the Grid X and Grid Y properties.  So the second image is placed at a distance equal to the Grid X value to the right of the first picture.  And the top of the second row of pictures starts at a distance equal to the Grid Y value below the top of the first row.  You can choose to print the image on all the report's pages, on only the first page, or you can choose not to print it at all.  Once you have specified all the options for the picture, you close the Properties dialog box.  You can then preview the report in the Preview window.

6 OF 7 (6-7 SUBREPORTS)

A report can have only one underlying data source, which must be a table or a query.  So if you want to combine data from different sources in one report, you can use the subreport control to do so.  You are most likely to use this feature when the second report already exists because otherwise you may prefer to create a query to combine the two data sources.  To combine different data sources in one report using a subreport control, you need to have a main report, which contains the subreport or subreports.  A main report does not need to have an underlying data source - it can merely function as a container for the subreports.  A main report can contain an unlimited number of subreports.  However, Access supports only three levels of main reports and subreports.  So subreport A may contain subreport B as long as subreport B does not contain any subreports.  If the main report and the subreport need to synchronize their data, the data source of the subreport must be related to the main report's data source by means of a common field defined as a table relationship.  Or the two data sources must be related by means of a field that has the same name and data type.
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Suppose you want to add the total sales achieved for each product to the Detail section of your Product Popularity report.  This information is already available in an existing report, named Products Per Order, which is based on the Order Details table and it adds the quantities ordered of each ProductID.  This report is also used as a subreport in other main reports, such as the monthly sales report.  The Products Per Order Report uses the ProductID field and Quantity fields to calculate its totals.   The ProductID field will be used to synchronize this report with the Product Popularity report.  You do not want the ProductID and Quantity controls to print in the main report - you are interested only in the total quantity ordered of each product so you need to set their Visible property to No.  In your main report - Product Popularity - you click the Subreport button in the Toolbox to insert a subreport control.  The moment you click the report at the position where you want to insert the subreport, Access launches the SubReport Wizard.  You can build a new subreport from tables or queries or you can use an existing report.  In this case you select the Products per Order report and click Next.  Because the report has been designed previously, the wizard has all the information that it needs so you click Finish.  The subreport appears as an ordinary control in the main report.  You can see in the subreport's Properties dialog box that the wizard has linked the ProductID field of the subreport to the ProductID field of the main report.  When you now preview the report, it shows the total number of units sold for each product.

END OF ENHANCING REPORTS

SUMMARY: You have seen how to enhance reports by adding pictures, changing object properties, and adding subreports.  Instead of using a wizard or the AutoReport feature, you can design a report from start to finish yourself. You do this in Design view. To add controls, you need to use the Toolbox or the field list that is provided in some cases. Access provides formatting and resizing tools to help you with the design process. To add a graphic to a report, you insert an Image control where you want the graphic to appear and then you link it to a graphic format file on disk.  The Format menu contains useful options for laying out a report. From here you can select to align objects and to change their vertical and horizontal spacing. You can also group objects in order to work with them as one object.  To enhance the appearance of your report, you can change the properties of controls and sections. For example, you can change the font size, underlining, and text alignment of text box controls. You can change the height of a section by dragging its size on the vertical ruler or by setting the Height property.  To sort the print sequence of records in a Detail section according to a field's value, you change the Sorting and Grouping settings for that section.  By adding a picture to the Report properties, you can display a graphic in the background of the report. You can choose to embed or link the picture and you can specify its size. It is possible to tile a picture and specify the grid settings for tiling. You can also suppress the picture on certain pages.  A report can have only one underlying data source, which must be a table or a query, so if you want to combine data from different sources in one report, you can use the subreport control to do so. To use subreports, you design a main report that contains subreport controls. A main report may have an unlimited number of subreports but reports may only be three levels deep. If the data in the main report and the subreport needs to be synchronized, you use a common field in their data sources or fields that have identical names and data types in the two data sources.  When you insert a Subreport control, Access automatically invokes a wizard that helps you to design the subreport.

UNIT TEST:

1. How do you insert page numbers on an Access report?

a. You insert an autonumbering field in the Page Footer section

b. You create a calculated control that uses common expressions in the Page Footer section

c. You type the number in the Page Footer section

2. How do you insert a graphic in an Access report?

a. By adding an Image control and then editing it with a graphic tool like Microsoft Photo Editor

b. By activating the Drawing toolbar and creating the picture in the report's Design view

c. By adding an Image control and then linking it to a file on disk

3. To work with a number of controls as though they were one object, you can _____ them.

a. redefine

b. select

c. group

4. How do you to sort the print sequence of records in a section according to a field's value?

a. By accessing the Sorting and Grouping settings for that section

b. By inserting the field in that section and then changing the field's properties

c. By accessing the report's properties

5. In Access reports _____ pictures reference the source file so that changes to that file will be reflected in the picture on the report, whereas _____ pictures are copies of the source file's image.

a. embedded

b. linked

6. How many subreports can main reports contain?

a. 3

b. 256

c. 1024

d. Unlimited

7. How many levels of reports with subreports does Access support?

a. Unlimited

b. 3

c. 2

8. Which of the following do you need to combine different data sources in one report and to synchronize the data?

a. A subreport

b. A main report

c. A subreport control in the main report

d. A data field that is common to the different data sources

9. Which of the following can you use to build a subreport?

a. Tables

b. Queries

c. Forms

d. Reports

ANSWERS:

1. b***(a)

2. c

3. c

4. a

5. 1st blank: linked, 2nd blank: embedded

6. d***(b)

7. b

8. a, b, c & d***(a)

9. a, b, c & d***(c)

INTERMEDIATE ACCESS

QUERIES

1 OF 14 (1-2 FILTERS IN A QUERY)

When running a query, you may want to view only a part of its recordset.  To narrow the range of records displayed, you can create a subquery.  But filtering the records - although less flexible than a subquery - is a quicker and easier method to extract records.  In Datasheet view there are three main ways to apply a filter to a query's recordset:

• by selection

• by form

• using advanced filtering or  sorting options

It's useful to filter by selection when you need to filter records quickly using a single criterion.  It is possible to apply successive filters - each with a different criterion - to narrow the scope further.  Filtering by selection allows you to find all the records that contain a particular value that you specify.  You can also filter by excluding the selection to extract all records that don't contain a particular value.  Before filtering by selection, you need to select an instance of the value that is required in the filtered records.  You select the entire field entry - in this case Discount Sports - if you want to view records with identical field values.  You select the beginning part of the field entry if you want to view records in which the specified field begins with the selected value.  And you select a part of the field entry after the first character if you want to view records that contain the value at any point in the field.  Filtering by form allows you to filter using more than one criterion.  Choosing to filter by form opens a Filter By Form window.  When you enter a value for more than one field on the Look for tabbed page of the Filter By Form window, Access filters for records that contain matches for both field values.  Filtering by form allows you to define "or" filters.  When you enter field values on the Look for tabbed page, the Or tabbed page becomes available and you can then enter different values in the fields.  Then when you apply the filter, all the records matching the criteria specified on either of the tabbed pages are extracted.  Entering values on an Or tabbed page causes another Or tabbed page to become available.  Filtering by form allows you to use logical expressions and operators other than "or" as criteria.  For example, you can use the "greater than or equal to" sign to filter for values that are greater than or equal to a value - in this case a date - that you specify.  After applying a filter to a query's recordset and viewing the results, you can delete it permanently or remove it and reapply it as required.  To permanently delete a filter, you need to switch from Datasheet view to the Filter By Form window by clicking the  
Filter By Form button.You then select Edit - Clear Grid and you click the Apply/Remove Filter button.  You temporarily remove a filter by clicking the Apply/Remove Filter button.  You can save a filter with a query - but only the last filter you applied is saved.  If you want to save a filter as a separate object, you need to save it as a query.
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Let's say you want to view only those records in a query's recordset that have the value "Shorts" for the Product Name field.  As only one criterion needs to be specified, you decide to filter the records by selection.  To filter by selection, you first select an example of the "Shorts" value.  You select the entire entry because you want to find records with values exactly matching it.  To apply the filter, you click the Filter By Selection button on the Query Datasheet toolbar.  You can also select Records - Filter - Filter By Selection.  Access now displays all the records that have the value "Shorts" in the Product Name field.  Suppose you have a query that displays the quantity of products ordered by customers and the dates of the orders.  You now want to find all the records that show swimwear ordered by Grand Club or P. James Distributors.  In Datasheet view you click the Filter By Form button to enter multiple filter criteria.  Alternatively, you select Records - Filter - Filter By Form.  Access now opens the Filter By Form window.  You click the Customer Name field to specify a value.  And you select Grand Club from the drop-down list.  To specify a product, you click the Product Name field.  And you select Swimwear from the drop-down list.  To specify an alternative set of criteria, you click the Or tab, which opens the Or tabbed page.  And you specify P. James Distributors as the customer name and Swimwear as the product.  To apply the filter to the query's recordset, you click the Apply/Remove Filter button.  Access now displays those records that have P. James Distributors or Grand Club as the customer name and Swimwear as the product.  To remove the filter, you select Records - Remove Filter/Sort.  Alternatively, you click the Apply/Remove Filter button again.  And this displays the original recordset again.  To save the filter as a query, you first switch to the Filter By Form window by clicking the Filter By Form button.  Then you click the Save As Query button on the Filter/Sort toolbar.  The Save As Query dialog box opens.  You type a query name and you click OK.  When you switch to the Database window, you'll see the new query listed.

3 OF 14 (3-4 TOTALS AND PARAMETER QUERIES)

Access allows you to create totals queries and parameter queries.  A totals query allows you to calculate totals for groups of data.  And a parameter query allows you to create a dialog box that prompts you for criteria each time you run the query.  You can create totals queries and parameter queries in the Query window in Design view.  You can also use the Simple Query Wizard to create a summary query, which is the same as a totals query.  Totals and parameter queries need to be based upon one of the other types of query - such as a select query or an update query.  To define a totals query, you need to click the Totals button to display the Total row in the design grid.  By default, Group By appears in the Total row for any fields you've already entered in the design grid.  When Group By appears in the field of the Total row, it indicates that all records with entries in that particular field, will be in the query's recordset.  To specify a calculation, you select an option from the drop-down list.  You can calculate the sum or average of the values, find the lowest or highest value in a field, or find the number, standard deviation, or variance of the values.  You can use a field for filtering out particular records from the groups in your query by selecting Where and specifying criteria in the Criteria row of the field.  Access clears the Show checkbox of fields with a Where setting and does not show them in the query results.  If you want to create a field that uses multiple functions in an expression, you select Expression from the list.  When you run the totals query, the calculated values are displayed - in this case the total amount of units per product on order for each customer.  Let's say you want to create a totals query that calculates how many units of each of your company's products are on order.  To do this, you first create a select query with the fields you need.  To display the Total row, you click the Totals button on the Query Design toolbar.  The Group By option appears in both Total cells.  As you want to view the unit totals by product, you accept the Group By setting for the Product Name field.  If you run the query at this stage, it will group the products together without providing totals.  To calculate how many units for each product are on order, you first click the Total cell of the Quantity field.  Next you click the down-pointing arrow.  And you select Sum from the drop-down list.  You click the Run button to run the totals query.  Access now displays each product with the amount of units ordered.
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To create a parameter query, you enter a phrase - in enclosed brackets - in the Criteria cell of the field that contains the values you'd like to use as parameters.  The phrase will function as the dialog box prompt when you run the query.  You can designate several fields as parameters in a parameter query.  And you can type expressions to specify ranges of values.  You can also combine a parameter query with a totals query.  Before Access executes a query, it prompts you for a value for each parameter.  And then it displays the records falling within the range defined by the parameters you specified.  Let's say you want to create a parameter query allowing you to view order details for a particular product during a certain period.  After creating a select query with the fields you need, you click the Criteria cell of the OrderDate field to specify text to use as a prompt and the parameter.  In this case you type an expression - Between [Type the first date:] And [Type the second date:] - that will allow Access to prompt you for two dates and then search the range of dates falling between them.  For assistance in building expressions, you can launch the Expression Builder by clicking the Build button.  To create a parameter allowing Access to search for order details of a single product, you type a prompt in the Criteria cell of the ProductName field.  When you run the query, it prompts you for each parameter in turn.  You type a value and click OK.  When you have entered the last parameter value, you click OK to run the query.  And the query displays the records falling within the range of the parameters.

5 OF 14 (5-6 MODIFYING QUERY PROPERITES)

A field that forms part of the output of a query brings with it the field properties defined in the original table.  But you can modify many of the field's properties by opening the Field Properties dialog box in the Query window in Design view.  When you open the Field Properties dialog box, it generally does not display the field's inherited properties.  You need to specify new properties to overwrite the inherited properties.  In query Design view, you can modify a field's

• description

• display format

• numeric format

• input mask

• column heading

• Lookup properties

When you specify a description for a field, you determine what appears on the status bar in Datasheet view when you click a row in the field's column.  The Format setting allows you to specify how you want the values you enter to be displayed.  And the Decimal Places property allows you to round off numbers to the decimal place you require.  If you want to enforce a certain format in which data needs to be entered, you use the Input Mask property to build an input mask.  And the Caption property enables you to specify a new column heading that differs from the field name.  On the Lookup tabbed page you can specify or override Lookup field properties.

6 OF 14

Let's say you want to modify the properties of a numeric field in a query by providing it with a field description, a display format, and a caption and by specifying no decimal places for the field values.  As you need to open the query in Design view, you select it in the Database window.  And you click the Design button on the Database window toolbar.  In Design view you click anywhere in the column of the field you want to modify - in this case the Quantity field.  And you click the Properties button to open the Field Properties dialog box.  You can also select View - Properties.Alternatively, you right-click and then select Properties from the shortcut menu.  On the General tabbed page of the Field Properties dialog box you type a description for the field - in this case Units On Order Per Product.  To specify a format for the field values, you click the Format property text box.  Then you click the down-pointing arrow to view the options.  And you select an option from the drop-down list - in this case you choose Standard to display the field's numerical values in a standard format.  To specify that no decimal places be shown, you click the Decimal Places property text box.  And you select 0 from the list.  To change the field's column heading, you click the Caption property text box.  And you type a new heading - in this case Products On Order.  You close the Field Properties dialog box by clicking the Close button.  Then to view the changes to the field, you switch to Datasheet view.

7 OF 14 (7-10 ACTION QUERIES AND SQL STATEMENTS)

You may need to change a large number of records in a database at the same time or add records that exist in a different Access database to the current database.  If you are making the same change to a number of records, it can be time consuming and tedious to enter the changes for each record individually.  Creating an action query allows you to change and add large amounts of data quickly and accurately.  The four types of action query are

• make-table

• append

• update

• delete

As you can't undo the changes once you've run an action query, it is usually a good idea to start with a select query and then convert it to an action query.In this way you can first verify that you're working with the right data before running an action query.  You use a make-table query when you want to create a new table from data in one or more existing tables.  A make-table query allows you to combine the fields you want in a new table and export the table to another database.  You can thereby avoid repeatedly running a select query against the same data, which may take minutes to execute if the data comes from different tables.  Let's say you want to make a table using the fields in your Product Order Details Query in the AwardOrders database.  And you want to export the new table to the AwardCustomers database.  You need to open the Product Order Details query in Design view and make sure it has all the fields you want in your new table.  To verify that you're working with the right data, you switch to Datasheet view.  After you've checked the fields and their data, you return to Design view and convert the select query to a make-table query.  To do this, you first click the down-pointing arrow next to the Query Type button.  Then you select Make-Table Query from the Query Type menu.  Access displays the Make Table dialog box.  In the Table Name text box you type a name for the new table - in this case Customer Order Details - or you select one from the drop-down list.  To save the table in another database, you select the Another Database radio button.  You then type the name of the other database, in this case AwardCustomers, and you click OK.  After setting up the make-table query, you can still change the name of the new table.  To do this, you click the Properties button.  The Query Properties dialog box opens.  You type the name you want in the Destination Table property text box and you click the Close button.  To create the table, you click the Run button on the Query Design toolbar.  A dialog box opens asking you to confirm the action and you click Yes.  To view the new table, you first need to open the AwardCustomers database.  Then you click the Tables button on the Objects bar of the Database window to view the list of tables.  And you double-click the name of the new table to open it.  Access now displays the table you created in Datasheet view.  As only basic field properties are reproduced in the new table, you may want to switch to Design view to define new properties.
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You use append queries to insert records from a table in one database to a table in another database.  For instance, let's say that you work with a database called AwardInventory and a database called AwardCustomers, which both have a Products table.  And suppose that you discover that there are more records in the AwardInventory Products table than in its equivalent in the AwardCustomers database.  To append records from the Products table in the AwardInventory database to the Products table in the AwardCustomers database, you need to link the former to the AwardCustomers database.  You link a table by selecting File - Get External Data - Link Tables when you are in the destination Database window, in this case AwardCustomers.  You then type the name of the other database, in this case AwardInventory, in the File name text box and you click Link.  You specify the table from which the records need to come in the Link Tables dialog box and you click OK.  The name of the linked table now appears in the AwardCustomers database.  Access has added a 1 to the linked Products table to distinguish it from the Products table in the current database.  Then you create a select query that contains the fields in the AwardInventory database that you want to add to the AwardCustomers database.  To create an append query, you select the Query menu.  And you launch the Append Query Wizard by selecting the Append Query option.  You can also click the down-pointing arrow next to the Query Type button and select the Append Query option.  In the Append dialog box you select the Products table from the drop-down list containing tables in the AwardCustomers database.  Then you click OK.  The Show row in the Query Design window changes to Append To and indicates the fields to which records will be appended.  If you click the Datasheet View button, you can see a preview of the product records that will be appended.  You execute the query by clicking the Run button.  And you view the results by opening the Products table in the AwardCustomers database in Datasheet view.
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An update query allows you to change values in one or more fields of a table for many records at the same time.  For example, let's say that you need to update the Products table in the Inventory database because the cost of all printed products has increased by 10 percent.  First you construct a query of the Products table that includes the ProductDescription field used to identify printed products and the UnitPrice field.  Next you click the Query Type down-pointing arrow.  Then you select the Update Query option.  In the Update To row of the Query Design window you type an expression to update the UnitPrice field.  In this case you type [UnitPrice]*1.1 to increase prices by 10 percent.  Then you specify the product description for printed products as a criterion - in this case you type Printed - and click Run.  A dialog box appears to warn you that you are about to update records and you click Yes.  When you open the Products table, you can see that the price of all Printed products has been increased by 10 percent.  Let's say that your company has stopped producing products that have no printing and you want to delete all the redundant records in the Products table.  To do this, you create a query containing one or more tables from which you want to delete records.  Then you select the Delete Query option from the Query Type drop-down menu.  To specify the table from which records will be deleted, you drag the asterisk (*) from the Products table to the Field row in the Query Design grid.  Then you either drag the field you want to use to specify the criterion into the next column of the Query Design grid or select a field from the drop-down list box.  You then specify a criterion that the field must contain for records to be deleted - in this case Blank for products with no printing.  If you click the Datasheet View button, you can see a preview of the products that will be deleted.  All the products have a value of Blank in the Category ID field so you can now return to Query Design view and execute the query.
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Every query has an underlying SQL statement that determines its operation.  A SQL statement is an expression defining a structured query language command, such as SELECT or UPDATE.  You can view or modify the SQL statement of a query in SQL view.  To modify a query's SQL statement, you need to be familiar with structured query language.  To view a query's SQL statement, you first open the query - in this case the Product Order Details query - in Design view.  Then you click the down-pointing arrow next to the View button on the toolbar.  And you select SQL View from the drop-down list.  Access opens the query in SQL view, displaying the query's SQL statement.  Any changes you make to the SQL statement will be reflected in Design view and in Datasheet view, for example deleting the whole statement will delete all the query's fields and data.  In this case you select the OrderDate field from the Orders table.  And you press the Delete key.  To return to Design view you click the down-pointing arrow next to the View button and select Design View.  You can see that the OrderDate field is now absent from the design grid.

FOOTNOTE:  If you're familiar with SQL, you can create queries by using SQL statements.  Among the queries you can create are SQL-specific queries, namely union, pass-through, data-definition, and subqueries.  You can create the first three by selecting SQL Specific from the Query menu and selecting the type of query you want.

11 OF 14 (11-12 SPECIFYING JOIN PROPERTIES)

Queries are powerful tools because they allow you to combine data from several tables or queries into one query.  When a query extracts data from more than one table (or query), their field lists need to be joined by join lines.  A join line tells Access how to associate the records in the different tables (or queries) with each other.  Without such a join line defining the relationship between the tables, Access displays every combination of the records in the two tables.This can result in large, unusable result sets because combining two tables with 100 rows each will result in a query with 10,000 rows.  Data sources are joined on a common field, such as those used in table relationships.  But Access can join tables on fields not present in table relationships as long as the fields have the same data type or compatible data types, such as AutoNumber and Number.  If you have defined relationships between the tables that you use in your query, Access automatically joins the tables on the fields that relate the tables.  And if you have chosen to enforce referential integrity, Access marks the tables with a 1 or an infinity symbol according to the relationship.  There are three types of join determining which records the query puts in its result set:

• inner join

• left outer join

• right outer join

A query based on two tables joined by an inner join displays only those records from the two tables that share equal values for the joined fields.  A query based on two tables joined by a left outer join displays all the records from the table on the left and only records from the table on the right if there are matching values in the joined fields.  A query based on two tables joined by a right outer join displays all the records from the table on the right and only records from the table on the left if there are matching values in the joined fields.  Choosing a primary and a secondary data source results in an outer join.  You can access and change the join type at any time by double-clicking the join line in the query Design view.  You can also right-click the join line and select Delete to remove the join.  You can configure Access to create joins automatically using compatible fields from unrelated sources by selecting the Enable AutoJoin checkbox on the Tables/Queries tabbed page of the Options dialog box.

12 OF 14

Suppose that you want to create a query that displays a summary of orders placed per customer.  To do this, you need to combine information from the Customers and Orders tables, which are related on the CustomerID field.  You want the query to display customers regardless of whether they have placed orders or not.  You start by creating a query based on the Customers table that includes the fields you want - CustomerID and CompanyName in this instance.  To add another table to the query, you right-click the section of the window that displays the field lists and you select Show Table.  To display the orders received per customer, you select the Orders table and you click Add.  And you close the Show Table dialog box.  Because the two tables are related on the CustomerID field, Access automatically inserts a join that reflects that relationship.  You can now insert the fields from the Orders table that you wish to display in your query - OrderDate in this example.  To change the join type, you select the View menu.  And you select Join Properties from the menu.  Access then opens the Join Properties dialog box.  You can also access the Join Properties dialog box by double-clicking the join line.Or you can right-click the join line and select Join Properties.  To return rows from the Customers table regardless of whether they have placed orders or not, you select the 2: Include ... equal radio button.  And you click OK.  Access has added an arrow head to the join line on the side of the Orders table to indicate that a left outer join has been created.  You click the View button to see the result set of your query.  Access then displays the result set.

13 OF 14 (13-14 OPTIMIZING QUERIES)

One of the ways in which you can optimize a query's performance is by creating indexes.  Indexing the fields that are most frequently queried helps Access to retrieve data more rapidly.  When searching for data, Access looks up the data's location in the indexes, which is faster than sifting through all the data in all the tables.  Although indexes are a useful tool for improving the performance of select queries, they can adversely affect the performance of action queries.  Because indexes need to be updated each time records are added to the indexed tables, they can slow down the entering of new records.  For these reasons, deciding which fields in a table to index can be complex, and testing is usually an important part of the implementation process.  The primary key of a table is automatically indexed.  It is usually a good idea to index fields that are used as foreign keys as well.  But you can't apply indexes to fields that contain OLE objects such as pictures.  You should consider indexing a field if it meets the following criteria:

• you will often search the table for  values contained in the field

• you will often sort the table  according to values in the field

• most of the values in the field are  different

Indexes of fields in which many values are repeated will not significantly improve the performance of queries and will slow down the entering of new records.  You can create an index of multiple fields if you are likely to run queries or sort records using more than one field.  Suppose you want to create an index of the FirstName and LastName fields in the Employees table of the AwardOrders database.  To create an index, you open the Employees table in Design view.  Then you click the Indexes button.  You can see the default index entry of the PrimaryKey field.  You type a name for your index in the space provided.  And then you choose the FirstName field from the list of options in the Field Name column.  To specify that the LastName field is included in the index, you select it from the list of FieldName options in the next row.  By default, the search order is Ascending but you can change it to Descending.  Once you have finished specifying the fields, you click the Close button and the index is generated automatically when you save the table.  To delete an Index, you select the row containing the name of the index and press the Delete key.  You repeat this for each index of a field that you want to remove.
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Apart from the creation of indexes, there are a number of other steps you can take to optimize query performance.  You can speed up query performance by always choosing the smallest data type appropriate for the data in a table field, for example Text rather than Memo.  The data types of fields used in joins need to be the same or at least compatible, such as AutoNumber and Number.  When you create a query, you need to keep the number of fields you want it to find to a minimum.  This means adding only fields that are really needed.  You can make a query faster by using the Group By setting as little as possible.  And if you want to group records by the values in a joined field, you need to specify Group By for the joined field that is in the same table as the field that will be totaled.  In this case you would choose the ProductID field from the Order Details table rather than from the Products table.  If your data does not change very often, you can consider creating a table by running a make-table query.  Then you can base forms and reports on the table rather than on a query, which needs to be run each time you want the results.  Queries perform better when you compact your database.  This is because the records of a table are then arranged in an orderly manner, making them easier to search.  You can get tips on how to optimize your queries from the Performance Analyzer.  To use the Performance Analyzer, you first switch to the Database window.  You can launch the Performance Analyzer from the Query window, but then it won't be able to analyze the query that is open.  In the Database window you select Tools - Analyze.  Then you select Performance.  You can also click the down-pointing arrow next to the Analyze button and then select Analyze Performance.  When the Performance Analyzer dialog box opens, you click the Queries tab.  Then you select the query you want to analyze - in this case Product Order Details - and you click OK.  As it couldn't find features in need of improvement, the Performance Analyzer tells you that it has no suggestions and you click OK.

END OF QUERIES

SUMMARY: You have seen how to work with queries.  Microsoft Access allows the user to apply a filter to a query's recordset. A filter is a quicker and easier way of finding records than a subquery.  Filtering by selection is used to find all records with field values that match a selected value. Filtering by form is used to specify multiple criteria by which to filter records.  After applying a filter and viewing its results, the user can remove or delete the filter. It is also possible to save the filter with the query and reapply it later or to save it as a separate query.  Access allows you to create a totals query that calculates totals - for example a sum or an average - for groups of data.  You can also create a parameter query that prompts you for criteria each time you run the query. This allows you to retrieve data falling within a certain range.  A field that forms part of the output of a query inherits its field properties from the table in which it was defined. But you can modify most of its properties, such as its display format and caption, in the Query window in Design view.  An action query can be used to create a new table using data from several existing tables. It is also helpful when you need to change or add many records to a table at the same time. In addition you can use an action query to delete records that have a common value in one or more of their fields. Action queries save you from having to enter or delete records in many successive acts.  Every query has an underlying SQL statement that you can view or modify in SQL view.  Queries are powerful tools because they allow you to combine information from several tables or queries into one query. To combine two data sources, you need to define a relationship between the two tables that specifies how Access must combine the two data sources when the query runs. Access can join tables on any fields as long as the fields have the same data type or compatible data types. There are two types of join - inner and outer. You can change a join's properties or delete it at any time. Access automatically creates joins on unrelated data sources if you configure it to do so.  Indexes are a way of providing Access with signposts that speed up its searches through large amounts of data. But although indexes improve the performance of select queries and sort operations that are run against the indexed fields, they can also slow down the performance of action queries and the entering of data in tables.  It is possible to create indexes of one or more fields. So if you frequently run queries against a table or sort the table by using two or more fields, you can create an index that encompasses both fields.  Apart from indexes there are a number of ways in which you can speed up query performance. This includes using smaller data types and restricting the number of fields in a query. To assess the performance of your queries and receive suggestions as to how to improve them, you use the Performance Analyzer.

UNIT TEST:

1. Which of the following statements about applying filters to queries are true?

a. You can choose to exclude records that contain a particular value

b. You can use part of a field entry to view records that contain the value at any point in the field

c. You are restricted to using the "or" operator when filtering by form

d. You can only remove a filter by specifying a new filter

2. It is possible to filter by selection when you have selected several field values.

a. True

b. False

3. Which of the following apply to saving filters?

a. You can save one filter per query

b. You can save several filters per query

c. You can save a filter as a filter

d. You can save a filter as a query in its own right

4. Can a query be both a totals query and a parameter query at the same time?

a. Yes

b. No

5. Which of the following statements apply to a totals query?

a. It always prompts you for criteria when you run the query

b. It calculates totals for groups of data

c. It can contain multiple totals functions in an expression

d. It searches for records matching parameters you specify

6. Which of the following field properties can you modify in Design view?

a. A caption

b. A default value

c. A display format

d. A validation rule

e. An input mask

f. A field description

g. The Lookup properties

7. Which of the following occurs when you specify a caption for a field?

a. The field name and the datasheet column heading reflect the caption

b. The datasheet column heading reflects the caption but not the field name

c. The field name reflects the caption but not the datasheet column heading

8. Which of the following statements are true of a make-table query?

a. It can create a table using several fields from different tables

b. The table it creates can be exported to another database

c. It reproduces all the original field properties in the new table

d. You run it every time you want to view the table

9. You use an _____ query to add records to a table and you use an _____ query to change the values in many records at the same time.

a. append

b. update

10. Which of the following statements about action queries are true?

a. The table from which data is being appended must be included in the query

b. You can use an action query to delete records

c. Action queries are used to create relationships between tables

d. Action queries can be applied to indexed fields

11. Only some queries are based on SQL statements.

a. True

b. False

12. A join that chooses only those records for which the join field from both data sources are equal is called an _____, while an _____ chooses one of the sources as the primary source and includes all records from that source but only those from the secondary source that have matching join field values in the primary source.

a. outer join

b. inner join

13. Suppose you want to create a query that is based on the Customers table and the Products table but no relationship exists between the two tables.  How can you go about creating such a query?

a. Define a join on the CustomerID and ProductID fields since they are of the same data type

b. Create a new table that adds the CustomerID field as a foreign key to the Products table

c. Create a form based on the Customers table and add fields from the Products table to the form

14. In which of the following circumstances would you be likely to create an index of a field?

a. If the field is regularly updated by an action query

b. If the field is frequently used to sort records

c. If values in the field are seldom repeated

d. If values in the field are regularly used as criteria in select queries

15. In which of the following ways can you improve the performance of a query?

a. By compacting its database

b. By using fields with large data types

c. By using many Group By settings

d. By limiting the number of fields

ANSWERS: I got a lot right based on lucky guesses so redo this section!

1. a & b

2. False

3. a & d***(abc)

4. Yes***

5. b & c***(abd)

6. a, c, e, f & g***(bd)

7. b***(a)

8. a & b

9. 1st blank: append, 2nd blank: update

10. a, b & d***(d)

11. False

12. 1st blank: inner join, 2nd blank: outer join 

13. a

14. b, c & d***(abcd)

15. a & d

INTERMEDIATE ACCESS

INTEGRATING AND SAVING DATA

1 OF 13 (1-5 IMPORTING AND EXPORTING DATA)

Access allows you to import data from an external source into a new table in your Access database or project.  You can also import other database objects - such as forms and reports - from another Access database or project.  And you can link to data from an external source without importing it.  It is possible to import and link data that has not been created in an Access format.  But Access must support the application using a different database, program, or file format.  When you import data, Access converts it from its original format before copying it into a new table in your database or project.  You can, for instance, import an Excel worksheet as an Access table.  But the source table or file remains unaltered.  Importing allows you to add only spreadsheet or text file data to existing tables.  However, once you have imported data in a new table in your database, you can perform an append query to add the data to an existing Access table.  Or you can add the imported table's data to another table using a stored procedure in an Access project.  Linking data to an Access database allows you to view and modify data in its original location without importing it.  You can link a table only in an Access database, not in an Access project.  The original application can still use the data because the original format remains intact.  But Access can now also be used to manipulate the data.  If you know that you will use only Access to work with data, you should import a table rather than link to it.  This is because Access generally works faster with tables in its own format.  And you can take advantage of your familiarity with Access to modify an imported table to suit your needs.  You can automate both the import and linking processes if these are frequently performed operations.  You do this by creating macros or Visual Basic for Applications procedures.  These automations can prove useful if you import or link data regularly to schedule or if your import or linking requirements are unusual or complex.
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Suppose you want to import data relating to your customer base in New York to your current database.  You can begin importing table data in three ways.  You can click the New button in the Tables window.  This opens the New Table dialog box where you select Import Table and click OK.  You can select Get External Data - Import from the File menu to begin importing data.  Or you can right-click the Database window and choose Import from the shortcut menu.  When you choose to import data using one of the three methods, this opens the Import dialog box.  You select the file that you want to import from and click the Import button or you simply double-click the file.  You are able to import objects from other Access databases by copying and pasting them into the current database.  The Import Objects dialog box appears and lists the objects that you can import according to the file type - in this case different Access objects.  You can specify the type of object or objects that you want to import by clicking the relevant tab.  You click the Options button to view and set various import criteria.  For tables you can specify that you want to import only the table's layout or the layout and the table's data.  You can import queries as queries or in the form of tables and you can specify whether or not you want to import relationships, menus and toolbars, and import/export specifications.  The table that you want to import is listed so you select it and click OK.  When the Tables window appears, you see that the table NYC has been imported.  You can open the new table by clicking the Open button or by simply double-clicking it.  And the table opens in Datasheet view.  Suppose you want to import the data in the NYC.xls file to a new Access table using the Import Spreadsheet Wizard.  In the Tables window of the database you want to import to, you select File - Get External Data - Import.  You select the database containing the XLS file you want to import data from before specifying Microsoft Excel in the Files of type drop-down list.  And you select the file and click Import.  The Import Spreadsheet Wizard appears with NYC selected by default so you click Next.  As the first row contains the column headings that you require as field names for the table you click Next.  You want to use a new table to store the data so you accept this default option and click Next.  On the next page of the wizard you are able to change various field options such as the name, the type of data it displays and whether the data is indexed or not, and whether you want to import the field at all.  But in this case you do not want to make any changes so you click Next.  And you want to allow Access to provide the primary key so you click Next.  You want to use another name for the new table so you change Access's suggestion of NYC to NYC3 before clicking Finish.  In this final wizard step you can enable options to have another wizard analyze the new table once the data has been imported and to display help once the Import Spreadsheet Wizard is finished.  A dialog box appears confirming that the Excel data has been imported successfully.  And you see that the new Access table has been added to the database.
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You should link data if a program other than Access also uses this data.  But you can also link tables from other Access databases.  This is useful for accessing different database tables on a network through one database on the network server.  You begin linking data using the Link Tables command that you access from the File - Get External Data submenu.  Or you right-click the Database window and select this command from the shortcut menu.  You can also click the New button to access the command in the New Table dialog box.  In the Link dialog box you select the file containing the table you want to link to and click the Link button, or you simply double-click the file.  And in the Link Tables dialog box you specify the table you want to link to by selecting the table and clicking OK.  Access now links the table to your database.  If the table that you are linking or importing has the same name as a pre-existing table in your database, Access automatically adds a number to the linked table's name.  This is because you cannot have two tables with the same name in the same database.
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You can export database items to other databases.  Or you can export these items to other formats, such as exporting the records in a database table to a Microsoft Excel spreadsheet.  You can also export the records in a form or report.  One way to export data to Excel is by selecting the data and using the Analyze It with MS Excel command.  You can export Access objects in Excel format by saving the data directly - with or without formatting - to an XLS file.  And you can view the data in an Access table in Excel format by using drag and drop to open the table in a blank Excel worksheet.  To export an Access object by saving it in Excel format, you select the object in the Database window and choose Export from the File menu.  Or you can select this command from the shortcut menu.  In the Export Table dialog box you select a version of Excel from the Save as type drop-down list.  And you specify a filename, or accept the default filename, and click the Save button.  To save only a selection of an Access object in Excel format, you need to first open the object in Datasheet view and make your selection.  In the Export…To dialog box you select the Save formatted checkbox and then select Save Selection.  Selecting the Save formatted checkbox preserves your data's format settings for fonts, displayed data from Lookup fields, and field widths.You can speed up the saving process by leaving this checkbox cleared.  If you specify an existing Excel file as the filename, Access overwrites the data in the original file if you are using an older version than Microsoft Excel 5.0.  But if you are using Microsoft Excel 5.0 or later, the exported data is copied to the next available worksheet and does not overwrite the original file.  A method of exporting data to Excel is to drag and drop a database object from the Database window directly into a blank Excel worksheet.  Excel immediately creates a spreadsheet using data contained in the object.  It places the field names from the datasheet in the first row of the spreadsheet.
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Suppose you want to export the data contained in your Employees table to an Excel spreadsheet.  You want to do this by saving the table's data to an XLS file.  And you want to view the data in the Products table by dragging and dropping the table into a blank Excel datasheet.  You begin by selecting the table in the Database window.  And you choose Export from the File menu.  Or you can right-click and select this command from the shortcut menu.  You can specify the version of Excel to save a table's output as so you select the version - in this case Microsoft Excel 97-2000 - from the Save as type drop-down list.  You accept the default filename and folder to save in, but you want to preserve the data's formatting so you select the Save formatted checkbox.  You click the Save button to save the data.  And Access creates the spreadsheet file Employees.xls using data from your datasheet.  To view the Products table's data in Excel format, you minimize Access and launch Excel by selecting Start - Programs - Microsoft Excel.  And a blank worksheet opens on your desktop.  You select the Products table in the Access Database window and you drag it across to the first cell in the blank worksheet in the Excel window.  The Products table then opens in the worksheet.

6 OF 13 (6-7 CHARTS AND LINKING DATA)

Access allows you to create charts in a form or report or in a data access page.  You use Microsoft Graph 2000 to create charts for forms or reports.  You can use a Microsoft Office Web Component called Microsoft Office Chart to create dynamic, interactive charts in a data access page.The page can be made available on web sites to be viewed in a browser.  You can choose from different chart formats, including two-dimensional and three-dimensional styles.  And the formatting options available to you include being able to add text and graphics, changing color schemes, and adding trendlines and error bars.  The Chart Wizard feature allows you to use the data from tables, queries, or other record sources to create charts.  The charts can be global, meaning all the data in the source object is used.  Or they can be record-bound, meaning that the source data is provided only by the current record.  You create a record-bound chart by selecting fields from drop-down lists in the Chart Wizard in order to link the chart to a form.  The chart then reflects the record displayed on the form at the time.  And it changes as you navigate between records on the form.  You use field boxes to configure the way data is represented on the chart.  At least one of the fields must have a data type that specifies a numerical value.  The field boxes provide the chart's data and the way in which they are configured determines the type of chart.  Three examples of field boxes are the Data, Axis, and Series field boxes.  The Data field box provides the data that you want to show on the chart.  The Axis field box is used to provide labels for the chart's horizontal axis.  And the Series field box provides labels for series, if you want to show this.  A chart in a form or report viewed in Design view shows only sample data.  You need to switch to Form view or the Print Preview window to view current data.  The Chart Wizard creates a query for the record source in the Row Source property.  This property specifies any restrictions on source data that you set in the Chart Wizard.  You cannot use the Chart Wizard to create a chart in an Access project, but you can add a chart by inserting the Microsoft Graph 2000 Chart object.
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Suppose you want to add a chart to a form that you have open in Design view.  To begin, you select the Chart option from the Insert menu.  And you click the position on the form where you want to place the chart.  The Chart Wizard dialog box appears and you specify the source data for Access to use in creating the chart - in this case the Products table - and click Next.  On the next page of the wizard you specify the fields that contain the data you want to show on the chart.  The only field that you are likely not to use is the ProductDescription field, so in this case it is easiest to first move all of the fields to the Fields for Chart list by clicking the Add All button.  Then you select the ProductDescription field and move it back to the Available Fields list by clicking the Remove button and you click Next.  You can use up to a maximum of six fields per chart.  You click the type of chart you want to use - in this case the 3-D Column Chart - and you click Next.  When you click a chart, you are given a brief description of the chart.  You can double-click a field box, for instance SumOfUnitsInStock, to view and change how the chart summarizes or groups data in the Summarize dialog box.  But this function is irrelevant in this case because there is only one number per field per product, so you leave this default setting and click OK.  You can drag field buttons to the chart - in this case you drag the UnitsOnOrder field to the Data field box that already contains the SumOfUnitsInStock field button.  You do this so that the two fields' data values are now subject to the same graphical parameter and can be compared.  You drag the ProductID field out of the Axis field box and replace it with the ProductName field.  You click the Preview Chart button to see the chart that is created with the new configuration of field boxes.  The chart preview takes the form of a global graph.  You click Close in the Sample Preview dialog box to return to the wizard.  And you click Next to move on to the next page.  You accept the default link on the next page of the wizard to create a record-bound chart and you click Next.  If you remove fields from the link defined here, you create a global chart and the chart will not be updated as you navigate between records on your form.  You type a name for your chart - or accept the default suggestion - and choose whether to display a legend, then you click Finish.  The chart appears on your form in form Design view showing only sample data, so you open the form in Form view by clicking the View button.  This opens the form with the chart displaying its current data.
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If you delete tables, data, or objects from an Access database or project, the database or project can become fragmented and use disk space inefficiently.  To counteract this, you can compact the database or project.  If you choose to compact a database, any repairs that need to be made to your database are carried out automatically.  Access Projects are not automatically repaired when they are compacted.  Access is able to detect if a database is damaged when you try to open it.  When this occurs, Access gives you the option to compact your database.  However, if Access does not detect an error and your database behaves unpredictably, it is recommended that you compact it.  Let's say that you want to compact the Stock Inventory database.  To compact a database, you first need to ensure that the database is closed on your machine and that no other user has it open.  You then select Tools - Database Utilities - Compact and Repair Database.  And you select the database that you want to compact, in this case Stock Inventory, and you click the Compact button.  In the Compact Database Into dialog box you can overwrite the original database with the compacted database by specifying the original name and location and clicking the Save button.  And in the dialog box that asks you whether you want the original database to be overwritten or not, you click Yes.  But in this case you want to specify a new name for the compacted database, so you type this name in the File name text box and click Save.  You now want to compare the sizes of the original and the compacted databases, so you select File - Open.  And you see that the original database has been compacted to 56KB.  Let's say that you want your database to be compacted each time it is closed.  To do this, you select the Tools menu.  And you select Options.  In the Options dialog box you click the General tab.  You select the Compact on Close checkbox and you click OK.  Now, whenever you close the database - unless another user has it open - it will automatically be compacted.
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When a database is shared across a network, it is often useful to split the database into a back end for data and a front end for code.  The Database Splitter utility in Access performs the database split into front-end and back-end automatically once activated.  It exports data tables to a new data-only database while deleting the original database tables and it creates links to the moved tables.  The back end is a shared resource, making both existing and new data available to every user in the form of tables.  And the front end comprises queries, forms, reports, macros, modules, and so on, which are created and used on separate users' computers.

Splitting a database reduces network traffic as only the table data, located in the back end, is transferred across the network.  Before you split a database, it is advisable to make a backup copy.  When you are ready to split the database, you open it in Access.  To activate the Database Splitter, you select the Tools menu.  And you select the Database Utilities - Database Splitter option.  To begin the splitting process, you click the Split Database button in the Database Splitter dialog box.  In the Create Back-end Database dialog box you define the name and the location of the back-end database, ensuring that the relevant users can share it.  And you click the Split button.  Once your database has been split, a dialog box informs you of the operation's status and you click OK.  And you are returned to the front end of the database.  You can then copy and distribute the existing front-end database.  If users add new forms, reports, and so on to their front end, these are not available to other user's front ends.  Splitting a database causes tables to become linked and keeping track of moved and linked tables is an important database management task.  To refresh linked table locations, you use the Linked Table Manager.  To access the Link Table Manager, you select Tools - Database Utilities - Linked Table Manager.  And you select the tables that you want to update - in this case you want to update all of them so you click the Select All button.  And you click OK.  Once the Linked Table Manager has updated the linked tables, you click OK.  And to close the dialog box, you click the Close button.
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You need to save the work you have been doing in a database only when you want to close the database.  You initially saved your database by naming it when you first created it.  This is because Access automatically saves your work as you enter records in database objects.  But when you make changes to the structure of a database object, you need to save these changes yourself - Access does not do so automatically.  When you close a database or one of its objects, Access displays a dialog box prompting you to confirm the save.  When you close Access, any databases you have been working in are closed with it.  Or if you have the Office Assistant enabled, the save prompt appears in the Office Assistant.  When working in Access, the Save option in the File menu is grayed out most of the time.  But if you open an object in Design view, the Save and Save As commands are available.  You can also use the Save button on the toolbar to save changes to database objects.  You can use the Export function to save the object in a format that another application can read - such as saving a table in Microsoft Excel format.  The Windows clipboard is available in Access to copy and save tables to other databases or applications with the Copy and Paste commands in the Edit menu.  You are given the option of pasting only the table's structure or both the structure and the data.  And you can choose to append the data to existing tables if the fields match up.  You are able to convert a database by saving it as a previous version.  To convert a database, you select the To Prior Access Database Version option from the Tools - Database Utilities - Convert Database submenu.  You need to provide a name for the previous-version database that you are creating before saving the database.  You will need to fix missing references after the conversion if the Access 2000 database contained code using Data Access Objects (DAO).  Unlike Access 2000, Access 97 is not designed to work with ActiveX Data Objects (ADO).  And you will need to convert any add-ins or library databases that were created in Access 2000 to Access 97.  If you get an error message saying that your computer is missing at least one of the Access 97 object libraries, you can correct this by opening the converted database in Access 97 and then opening one of the modules.  Once you have done this, you will need to clear the checkboxes next to any missing references.  And you set a reference to the Microsoft DAO 3.51 Object library.
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Once you have created a database or Access project, it is important to make backup copies of your data.  Backup copies need to be made at regular intervals.  It is recommended that if you store backups on your hard disk, you keep other backup copies on a tape or CD-ROM stored in a separate location.  You can use a variety of methods to back up data depending on the software that you have available to you and on the conventions of your organization.  For example, you can use Windows Explorer or My Computer when using a Windows or Windows NT operating system.  You can also use MS-DOS commands or specific backup software such as Microsoft Backup.  Suppose that you want to create a database backup and save it to a network drive using My Computer.  To do this, you first ensure that the database you want to back up is closed on your machine and that no other user has it open.  You can then minimize or close Access.  To access My Computer, you double-click the My Computer icon on your desktop.  You then navigate to the location of the database that you want to back up, or you type its address in the Address text box - in this case it is in the Personal folder on your hard disk.  Once you have selected the database that you want to back up, you select the Edit menu.  And you select Copy.  You navigate to the location where you want to store the backup database, in this case drive D\ CustOrders2_00.  And you select Edit - Paste.  It is advisable to rename your backup database using the .bak extension to avoid overwriting the original database.  To restore a database, you simply copy the backup version into the location that you want to access it from.  And you rename it using the .mdb extension and a different filename if the original database is in the same location.  It is recommended that you make a backup of the workgroup information file - if you have one - in addition to your database.  This is because if the workgroup file is corrupted or lost you will be unable to open Access.
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Access 2000 can create web pages from a database's tables, queries, forms, and reports.  You can export tables, queries, and forms as static or dynamic web pages.  And you can export reports as static web pages.  The dynamic web pages that Access creates are compatible with the Microsoft Active Server Pages (ASP) format.  Or you can choose the IDC/HTX format to create a dynamic web page.  Both these formats are compatible with Microsoft's Internet Information Server software but they are also compatible with many other web server packages.  When you create dynamic web pages, you need to connect these to an ODBC data source from where the web server can dynamically create HTML pages for the Web.  ODBC is an acronym that stands for Open Database Connectivity.It is a standard database access method developed by Microsoft.  These HTML pages are read only and they display information in a table format.  When you export a database object as a static web page, Access creates an HTML file that you can copy to your web server for publication on the Web.  These HTML files are compatible with most web server products.  Tables, queries, and forms display in datasheet format, while reports display in a report format in the web browser.  You have the option of creating an HTML template file that your published database objects will be based on.  An HTML template contains Access-specific tags and tokens specifying where to place a company logo, for example.  When you export a database object to the web, Access presents you with an Output Options dialog box and the file type determines the options available here.  For ASP files you can specify a template and you need to enter the ODBC data source information.  The data source is the Access database that contains the object that is being exported.  You can omit the user's name and password if you want to - Access then enters the Admin user with no password as the default.  In the case of ASP files you need to specify the URL for the web page and a timeout value.  The web server uses this information to create the HTML pages dynamically.  HTX/IDC-format files need information on the template - if used - and the ODBC data source.  For HTML files you need only specify the web template that you wish to use and this is optional.
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Suppose that you want to publish a query - based on the Employee table - on your intranet so that employees can look up phone numbers of their colleagues.  You want to create a dynamic web page so that changes are reflected and you want to use the Active Server Pages format.  You want to base the exported file on a template called web template.htm.  You start by opening the query - in this case you use Design view.  You select the File menu.  And you select the Export option.  In the Export Query dialog box you enter the web page's name and you expand the Save as type drop-down list.  Then you select the Microsoft Active Server Pages file type.  And you click Save.  In the Output Options dialog box you enter the name of the HTML template you want to use.  You also enter the ODBC data source information and the web server information and you click OK.  Access creates the ASP file in the location that you specified.

END OF INTEGRATING AND SAVING DATA

SUMMARY: You have seen how to integrate and save data in Access.  Access allows you to use data from an external source by importing it into a database or linking to it. Access can work with data from any application that it supports. Imported data is converted and copied into a new table, while linked data remains in its original location and is accessed there while remaining available to its own application.  Access allows you to export data to other applications, such as Microsoft Excel. You can export data to Excel using the Analyze It With MS Excel command, you can save the output of a database object - as both formatted or unformatted data - directly to Excel, and you can drag and drop a database object into a blank Excel worksheet to immediately create a spreadsheet.  Access includes Microsoft Graph 2000 to create charts for forms and reports. Tables, queries, and so on are the data sources for creating global or record-bound charts in differing formats that include three-dimensional styles. Graph provides different wizards to create these styles, which include formatting features such as text, graphics, and color.  Modifying a database can cause storage space to be used inefficiently. To improve storage use and enhance performance, you can compact your Access database or project. The compacting feature includes a repair utility that repairs your database as you compact it. This feature does not apply to Access projects, however.  Another way to improve database performance is to split your database into a back end consisting of data tables and a front end that contains objects such as forms, reports, macros, modules, and so on. This technique is particularly useful when sharing a database across a network. The Database Splitter utility performs this split automatically and links the back-end tables to the forms and reports running on user computers. The Linked Table Manager utility monitors and updates linked table locations ensuring the links remain in use.  Access automatically saves your work as you enter records in database objects. But when you make changes to the structure of a database object, you need to save these changes yourself. When you close a database, a database object, or the Access application, you will be prompted to save any changes you have made.  You are able to convert an Access 2000 database to Access 97. You will need to fix missing references after the conversion if the Access 2000 database contained code using Data Access Objects (DAO). And you will need to convert any add-ins or library databases that were created in Access 2000 to Access 97.  It is important to keep backup copies of your database to prevent loss or damage to your data. You can do this using various forms of software available. However, it is recommended that you do not store all your backup databases on your hard disk but rather that you keep a backup off site or on a network drive.  Access 2000 can create dynamic web pages from a database's tables, queries, and forms, while reports can be exported as static web pages. To create a dynamic web page, you need to export the database object in ASP or IDC/HTX format. You also need to define an ODBC data source for these web pages. Dynamic web pages are published as read-only tables. To create a static web page, you need to export the database object as an HTML file. Tables, queries, and forms published statically display as datasheets, while reports display in a report format. You have the option of using a template when you publish web pages.

UNIT TEST:

1. Which of the following statements apply to importing data in Access

a. Importing allows data to be added to existing local tables, except if they are Excel spreadsheets

b. Importing removes a database object from its original location and saves it in a local database

c. Importing converts data from its original format and copies it into a new table in a local database

d. Importing data allows an external non-Access application to utilize this data in Access format

2. Which of the following statements apply to linking to data?

a. It is possible to link to an object's data even if it is not Access data

b. There is no need to link to data if only Access will be used to work with the data

c. Changes made to linked data are not reflected in the source data in the original location

d. Linking is used for accessing only data that has been created by a non-Access application

3. Imported data can be appended to a table using _____ in an Access database and _____ in an Access project.

a. a stored procedure

b. an append query

4. Access works faster with tables created in Access than with those created by other applications.

a. True

b. False

5. Which of the following statements apply to saving an Access table as an XLS file?

a. A selection of the data can be saved

b. The data can be saved without its formatting

c. The data can be saved only as a Microsoft Excel 5.0 or later version file

d. The data is always saved to the default folder

6. Which of the following is the Chart Wizard able to create?

a. A chart in a data access page

b. A chart in a report

c. A chart in a table

d. A chart in an Access project

7. You can create a chart in Access that uses data from another application, such as a Microsoft Excel worksheet.

a. True

b. False

8. Which of the following statements about record-bound charts are true?

a. All the data in the source object is used for the chart

b. The data only from the current record is used for the chart

c. When you view a record, the chart changes to display the data from the current record

d. It can be used only for spreadsheet data

9. Which of the following occur when a database is compacted?

a. Storage space use is optimized

b. Databse performance is improved

c. Links to tables are updated

d. Any database repairs are carried out

10. You can compact a database while another user has it open.

a. True

b. False

11. In a split database _____ form the back end of the database.

a. queries

b. tables

c. forms

d. reports

12. Which of the following are true of Access database utilities?

a. Splitting a database reduces network traffic

b. The Linked Table Manager creates links between tables and other database products

c. Splitting a database automatically creates linked tables

d. The Linked Table Manager updates linked table locations

13. Which of the following are true of backing up an Access database?

a. It should only be backed up or restored using MS-DOS commands

b. It is recommended that a backup is made on tape or CD-ROM and stored in a separate location

c. Microsoft Backup should always be used to back up Access databases

d. Backups should be performed when the database is closed

14. It is advisable to use a different name than that of your original database for your backup database.

a. True

b. False

15. Which of the following Access database objects can you export as dynamic web pages?

a. Reports

b. Tables

c. Queries

d. Forms

16. Access automatically saves changes to _____ in a database, while you need to save changes to _____ yourself.

a. objects

b. records

17. Suppose you want a web page where customers can enter orders from your web store, which is linked to an Access database.  Which of the following actions will achieve this aim?

a. Exporting a table as an HTX/IDC file

b. Exporting a form as an HTML file

c. Exporting a report as an Active Server Page

ANSWERS:

1. c

2. a & b

3. 1st blank: an append query, 2nd blank: a stored procedure (lucky guess)

4. True

5. a & b***(c)

6. a & b***(cd)

7. True

8. b & c***(cd)

9. a, b & d

10. False

11. b

12. a, c & d***(bc)

13. b & d***

14. True***

15. b, c & d(lucky guess)

16. 1st blank: records, 2nd blank: objects

17. b***(c)

END OF INTERMEDIATE ACCESS

